
© 2014

just:in multi
Installation & User Manual

for just:in multi v1.7 and later

Mac OS X 10.9 and higher only!

tools ‡ air
broadc as t  eng ineer ing  gmbh



address Zirkusgasse 39 | A-1020 Vienna | Austria | phone +43 (0)1 236 8665 | website www.toolsonair.comtools ‡ air

tools ‡ air
b r o a d c a s t  e n g i n e e r i n g  g m b h

Version: Date: Changes:
1.0.0 09.05.2014 Release version of just:in multi v.1.7 manual.
1.0.1 16.05.2014 Updated description of new installer process.
1.0.2 11.06.2014 Updated audio preview description.

ToolsOnAir - Broadcast Engineering GmbH
Zirkusgasse 39
1020 Vienna
AUSTRIA

VAT ID: ATU 64362718

www.toolsonair.com
sales@toolsonair.com

Software and about user guides described in this document are protected by copyright. No reproduction, distribution 
or use in whole or in part of any content is permitted without prior authorization of ToolsOnAir - Broadcast Engineering 
GmbH ("ToolsOnAir"). Any use, for any purpose, not allowed in the terms of the license is strictly forbidden. 
ToolsOnAir uses reasonable efforts to include accurate, complete and current information in this document, however, 
ToolsOnAir - Broadcast Engineering GmbH does not warrant that the content herein is accurate, complete, current, 
or free of technical or typographical errors. ToolsOnAir - Broadcast Engineering GmbH reserves the right to make 
changes and updates to any information contained within this document without prior notice. ToolsOnAir - Broadcast 
Engineering GmbH shall not be responsible for any errors or omissions contained in this document, and in particular 
ToolsOnAir - Broadcast Engineering GmbH shall not be liable for special, indirect, consequential, or incidental damages, 
or damages for lost profits, loss of revenue, or loss of use, arising out of or related to the information contained in 
this document, whether such damages arise in contract, negligence, tort, under statute, in equity, at law or otherwise. 
All rights reserved.

© 2014 Tools on Air - Broadcast Engineering GmbH
All trademarks and registered trademarks are the property of their respective owners.



address Zirkusgasse 39 | A-1020 Vienna | Austria | phone +43 (0)1 236 8665 | website www.toolsonair.comtools ‡ air

TABLE OF CONTENTS
1. Introduction   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1

1 .1 The Applications   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2

2. Setup  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3
2 .1 Requirements   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3
2 .2 Installation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4

3. Configuration   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 6
3 .1 Just In Engine QuickTime Engine   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 6
3 .2 Channels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 6
3 .3 Presets: Define Capture Presets   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 10
3 .4 Presets: Define Multiple Destinations Presets   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11
3 .5 Presets: Apple ProRes, Avid DNxHD and H .264   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 12
3 .6 Naming Convention Presets   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 12
3 .7 Activation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 13

4. Using the Application  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 14

5. Interface   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 16
5 .1 Preview   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 17
5 .2 Record Button & Timecode Display  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 18
5 .3 Capture Instances Settings   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 18
5 .4 VTR Control  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 19
5 .5 Batch Recording   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 20

6. Recording  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 21
6 .1 Record Button States  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 21
6 .2 Crash Recording  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 22
6 .3 Batch Recording   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 23
6 .4 Scheduled Recording   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 24
6 .5 Video Preview Quality and Speed settings   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 26
6 .6 Just In Adobe Panel for Adobe Premiere Pro CS6/CC  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 27

7. Creating Customized XML  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 28
7 .1 Setting up the XML export requirements   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 28
7 .2 Setting up the XML Destination in the preference panel  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 28
7 .3 About the logic behind the XML export   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 29
7 .4 Exploring the Example file in the StartupXML folder  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 29
7 .5 Exploring the Example file in the ExportXML folder  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 30
7 .6 Internal System Variables (Capture and General)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 31
7 .7 Writing Metadata in a QuickTime file   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 33

8. Using Moxa NPort 5650   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34

9. Known Issues  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35



1address Zirkusgasse 39 | A-1020 Vienna | Austria | phone +43 (0)1 236 8665 | website www.toolsonair.comtools ‡ air

1 INTRODUCTION
just:in multi is an innovative Apple Macintosh-based ingest solution that offers crash, gang, batch 
and schedule recording and features single or multi-channel video capture over SDI into MOV, 
MXF and MP4 containers. just:in multi unites single and multi-channel ingest into one flexible and 
therefore expandable application.

Supported Formats
PAL, NTSC, HD, UHD (QT only!)

QuickTime 
(QT 7 and AVFoundation)

MXF 
(D-10, GC, XDCAM, Avid OP-Atom)

Supported FPS (vendor and card specific): 23.976, 24, 25, 29.97, 30, 50, 59.94, 60

• DV, DVCPRO25/50
• DVCPRO HD (720 and 1080)
• IMX MPEG 30/40/50 

(625/50, 525/60).
• All Apple ProRes and most 

Avid DNxHD (8-bit) codecs.
• Uncompressed SD/HD(8-/10-bit).
• H.264: MP4 and MOV (AVF).
• UHD: 3840x2160p resolution.

• DV, DVCPRO50
• DVCPRO HD
• IMX MPEG 30/40/50 

(625/50, 525/60)
• Avid DNxHD (Avid OP-Atom)
• Uncompressed SD/HD in 8-bit
• XDCAM (PAL), XDCAM EX, HD, 

HD 422
• AVC-Intra 50 / 100

VTR Control RS-422

Supported Capturing Devices 
(contact ToolsOnAir for devices 
not shown in this list)

AJA Blackmagic

PCI Cards:

• KONA 3G
• KONA LHi
• KONA LHe Plus
• Corvid 22
• Corvid 24

Thunderbolt devices:

• Io XT
• Io 4K

PCI Cards:

• DeckLink Mini Recorder
• DeckLink SDI / DeckLink SDI 4K
• DeckLink Studio / Studio 4K
• DeckLink HD Extreme 3 / 3D
• DeckLink 4K Extreme
• DeckLink Quad

Thunderbolt devices:

• UltraStudio Mini Recorder
• Ultrastudio 3D / Express
• UltraStudio 4K
• Intensity Extreme

Recording Modes Crash / Gang, Batch or Schedule (using Apple Calendar)

Other Features

 ρ 2 (two) separate recording instances per channel.
 ρ Multiple Destinations Support.
 ρ Growing file support in Final Cut Pro 7/X or Adobe Premiere Pro CS6 

/ CC (Mac) with QuickTime MOV and MXF.
 ρ Edit-While-Ingest functionality (MOV, MXF).
 ρ Split-While-Recording functionality.
 ρ Support for customizable QuickTime and XML-Metadata. 
 ρ Moxa NPort 5650 Serial Device Server Integration.
 ρ UHD recording available for QuickTime and AVFoundation 

containers only!
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Goals of this document

 ρ Installation, configuration and usage of just:in multi.
 ρ Customization of sidecar XML files.
 ρ Deployment of Just In Adobe Panel for Adobe Premiere Pro CS6 and CC.

INTRODUCTION

THE APPLICATIONS1.1 

Just In Engine QuickTime

Just In Engine QuickTime is the engine responsible for ingesting one or more 
SDI signals attached to an input card or cards (e.g. AJA, BMD) and writing these 
signals into a given container (MOV-QT, MOV-AVF, MXF OP1a, AVID OP-Atom 
MXF or MP4). A single Just In Engine QuickTime can support multiple channels 
in SD and HD as well as single channels in UHD/4K depending on the framerate, 
TV norm, container and codec used, the available qualified Apple hardware and 
the storage attached to the system. The engine supports crash, gang, batch and 
scheduled recording modes as well as RS-422 VTR machine control.

Just In Multi

Just In Multi is the interface for single or multi-channel ingest. It controls 
multiple channels available from multiple instances of Just In Engine QuickTime 
on the network. The user interface provides live feedback about the status of 
the channels (real-time video and audio previews) and diagnostics about the 
systems on which the Just In Engine QuickTime is running. The user can then 
start and stop recording, build and execute batch lists, control connected video 
tape machines (VTR control), view any pre-defined schedules to be recorded and 
add metadata.

Just In Adobe Panel

In addition to the Just In Multi user interface, there’s the option to use our Just In 
Adobe Panel for Adobe Premiere Pro (Mac) to directly record and import files into 
Adobe Premiere Pro CS6 (6.0.5) and CC (7.2.x and higher). It currently provides 
single/multi-channel ingest over SDI or HDMI (depending on the PCI video card 
or Thunderbolt device used) in combination with our Just In QuickTime Engine. 
The automatic import into the Adobe Premiere Pro project panel with growing file 
support (MOV and MXF) eliminates the complexity of running several applications 
in an editing environment.
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2 SETUP
SETUP

REQUIREMENTS2.1 

The number of channels that qualified Apple hardware can record will depend on the format, framerate,  
selected codec, the speed of the storage, and the number of CPU cores available. For multi-channel 
recording on a single machine we therefore recommend the highest specified CPU currently available 
and a storage device able to read and write at least twice the theoretical data rate required by the 
specific codec multiplied by the number of channels being recorded.

For example, recording high definition 1080 streams in ProRes HQ would require an Apple Mac Pro   
or Apple Mac mini with the minimum specifications stated below:

Qualified Apple Mac Models for just:in multi

PCI-Card setups: MacPro 12-core (5,1). Please note that support for legacy hardware like the 
Xserve (3,1) models and older Mac Pros (3,1, 4,1) has been discontinued.

Thunderbolt setups: Mac Pro (6,1) 8- or 12-core, Mac mini Quad-Core (6,2). Currently the max. 
amount of recordables channels in HD on a Mac mini i7 2012 (6,2) is 2!

Clients: iMac Quad-Core i7 (13,1 - 13,2 and 14,1 - 14,2) recommended.

If you are having trouble to determine the Model Identifier, then click on the Apple Menu on the appropriate Mac and 
select “About This Mac” while pressing the “Option/Alt” key. The System Profiler will shows up and display data 
relevant to your machine.

RAM At least 8 GB (16-64 GB recommended).

Operating System
Mac OS X 10.9.2 or later.
Administrator account required.

Other
Variable framerate devices like the FaceTime HD Camera 
are not supported!
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SETUP

INSTALLATION2.2 

Before you begin make sure that you have Mac OS X 10.9.2 or higher installed as well as the current 
drivers from either AJA or Blackmagic Design. 

NOTE: just:in multi version 1.7 will ONLY run on Mac OS X 10.9.2 or higher! 

Double-click on the DMG installer image and click Agree to accept the license agreement. To install 
Just In 1.7 drag and drop the installer icon onto the Applications folder.

For NEW installations:

 ρ Navigate to the /Applications/Just In folder and double-
click on Just In Engine QuickTime to initialize the software 
packages. You will be asked to update your system and to 
allow access to system resources such as Apple Calendar. 
Confirm all of them by clicking OK and by entering your 
credentials when asked.

 ρ The next step is to activate your channel(s). Click on 
Activate and the Just In QT preference pane will open up 
for you to fine tune your configuration.

For UPGRADE installations ONLY:

 ρ In case of a previous activation of any version prior to 
v.1.7 you will need a new activation code. Please contact 
ToolsOnAir to receive your updated activation code under 
software maintenance. To perform an upgrade install, you 
can follow the same steps above. Drag the Just In installer 
package to the Applications folder and confirm that you 
want to replace (Replace All) the older version of Just In.

 ρ Navigate to the /Applications/Just In folder and double-
click on Just In Engine QuickTime to initialize the software 
packages. You will be asked to update your system and to 
allow access to system resources such as Apple Calendar. 
Confirm all of them by clicking OK and by entering your 
credentials when asked.

 ρ Your capture presets will be kept as well your channel(s) 
information. Only the destination presets need to be 
recreated in the Just In QT preference pane in order 
to reflect the new multiple destinations structure 
(see pages 11 and 12).

 ρ Once the upgrade setup is done, restart Just In Engine 
QuickTime, launch Just In Multi and connect to the 
desired channels.

Where to look for just:in multi components after the installation process :

 ρ Just In Multi.app: /Applications/Just In/
 ρ Just in Engine QuickTime.app: /Applications/Just In/
 ρ Just In QT.prefPane: /Library/PreferencePanes/
 ρ Tools On Air Preferences.prefPane: /Library/PreferencePanes/
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Note for AJA KONA Users

 ρ just:in multi 1.7 has been designed to take care of all sort of internal cabling between 
the KONA cards and the Just In Engine QuickTime engine, so that the user need not 
to configure the settings through the AJA Control Panel. For best audio performance 
use the option “Line In” in System Preferences -> Hardware -> Sound -> Input. 
Changing this setting to “AJA Kona (name of card)” might lead to recordings with 
asynchronous audio!

 ρ just:in multi 1.7 has been designed to take care of all sort of signal handling between 
the KONA cards and just:in. Please note that failing to provide a continuously stable 
signal, during a capture process could interrupt your ingest process or harm the file 
saved to disk by making them out-of-sync or even unusable at all. In order to stabilize 
the signal in advance, i.e. before it’s sent to the video card input, you can use Audio/
Video Frame Synchronizers from the AJA FS or UDC family of products.

 ρ With the KONA 3G, Corvid 24 PCI cards and the Io 4K PCI Thunderbolt device you 
will be able to record up to 4 incoming SDI streams, thanks to just:in multi’s direct 
SDK link.

 ρ With the Io XT Thunderbolt device you will be able to record up to 2 incoming SDI 
streams, thanks to just:in multi’s direct SDK link.

 ρ Version 1.7 of just:in multi will support AJA drivers 10.5.2 and higher only!

Note for Blackmagic Decklink Users

 ρ We do NOT recommend the use of 2 DeckLink Duo cards to achieve a 4 channel ingest  
station due to extended thermic problems and reported frame loss issues. Please use 
the DeckLink Quad card instead which is the approved setup for multi-channel input! 
This refers to both the Mac Pro 5,1 and any external Thuderbolt extension chassis.

 ρ It is recommended to use the Blackmagic Desktop Video drivers versions 9.9.3 or 
10.x of for full compatibility with Mac OS X 10.9 Mavericks and fixes with regard to 
channel reallocation upon restart.
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3 CONFIGURATION
CONFIGURATION

JUST IN ENGINE QUICKTIME ENGINE3.1 

Open the System Preferences and select the Just In QT preference pane under Other. Before you 
can continue, please authenticate yourself by clicking on the lock (Make Changes) icon and entering 
the administrative credentials. In the Just In QT preference pane you will see five tabs.
 ρ Under Engine select the desired framerate (23.976, 24, 25, 29.97, 30, 50, 59.94 or 60).
 ρ Check “Continue writing into same container after signal loss” if you would like to keep the 

container opened during a signal loss and have just:in multi resume the recording into the same 
container as soon as a signal is fed again. If not checked and in the event of a signal loss, just:in 
multi will stop recording, close the container and resume recording into a new file as soon as a 
proper signal is fed again. This applies to both QuickTime and MXF containers in Crash mode only. 
We highly recommend using use frame stores to guarantee a stable and correct input signal.

 ρ Check “Preallocate diskspace when writing QuickTime” if you want just:in multi to preallocate 
disk space in order to prevent file fragmentation (extends). The amount of allocation needed is 
automatically calculated by just:in multi according to the capture preset (codec) selected. This 
option is not recommended for XSan deployments.

 ρ Check “Use fallback frame count” if you want to set a given amount of frames (max. 100) that 
should be buffered before switching to the fallback destination set in the Just In QT preference 
panel. When reached, just:in multi will fallback onto the defined fallback storage.

CONFIGURATION

CHANNELS3.2 

 ρ Under Channels select the available channels that you 
would like to use by clicking on the appropriate checkbox 
and choose the appropriate settings for the channel. The 
available video mode settings for the previously selected 
framerate will be displayed automatically.

 ρ Choose Publish Bonjour service if you want to use 
Bonjour for network discovery. In case that Bonjour 
cannot be routed in your network, check  Local Mode 
to run a network agnostic version. If you plan to re-use 
Bonjour again later in time, then make sure to enter 
“0” as the port number. Please consult your network 
administrator on port availability.
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On the left side you can see all the video capture devices found by the engine, as well as the names 
given to those devices. Please select a device to configure it.

1 2

3

4

5

6

7

8

1 Capture Devices: Lists all video capture devices found by the engine.

2 Name: Define a channel name.

3 Device: Shows the device manufacturer. Left blank intentionally.

4 Video Mode: Configure the video device. The available video mode settings for the 
previously selected engine framerate will be displayed automatically.

5
Video Input, Audio Input and Audio Bitrate: Selectable Video and Audio Input 
settings as well as native 24-bit bitrate for AJA, selectable 16- or 24-bit for 
Blackmagic Design cards.

6 VTR Control: Select the connection you want to use to control your VTR.

7 VTR Preroll in Seconds: Set the desired VTR preroll value in seconds (1-10).

8

Chunk Length: The Chunk Length defines the maximum length of the container. If 
the recording does not reach the entered Chunk Length, the clips will be automatically 
truncated into the expected recorded length. If the recording exceeds the entered 
Chunk Length a new recording, generating a new clip, will automatically be started. 
When recording in crash mode, clips will be added after the maximum record length 
has been reached. It is not required to enable this feature separately as it is enabled by 
default. The maximun chunk length is 12 hours.

9
Start Timecode: By selecting this option and entering the appropriate timecode 
information, every new clip will start / record with the given timecode preset.

Continued on next page.

9
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Continued from previous page.

1

2

3

4

5

1

Cache Options: Normally files are written to disk in a stream (no caching, default). 
You can ask the HDD-Controller to cache data in order to flush them later to disk to 
improve write performance. Change this value to “Cache” if you experience low write 
performance, otherwise keep the default “Don’t Cache” setting. 

2 Video Output Buffer (QuickTime only): Number of A/V frames to flush to the storage 
system at once. If you want to flush once a second, just enter your video framerate.

3

Output Buffer Segments: Number of buffer segments. The number of segments 
multiplied by the storage flush size is the total buffer size. Be careful when using that 
feature, as you can run out of RAM. It is recommended not to exceed a total buffer size 
of 500.

4

Audio Preview Port: enter a port number of choice to enable the audio preview in 
the Just In Multi GUI for that particular channel. 

Engine Port: when using “Publish Bonjour service” it defaults to “0” since the 
Bonjour discovery mode will deliver the available information to the Just In Multi 
GUI. Please enter a dedicated port number, if you want a channel to be accessed  from 
Just In Multi over IP (see also pages 15-16 of this manual for further explanations).
Consult your network administrator for port availability for both settings. When 
selecting “Local Mode” it will default to port number 65010 and on.

5

Local Mode: This mode allows to run a network agnostic version whenever engine 
and GUI are on the same machine. Choose “Local Mode” and start/run the Just In 
Multi GUI. It will automatically start both the engine process and connect to the 
channels selected in the Just In QT preference pane. While this option comes  in 
handy for Bonjour-less setups, it is recommended to use the IP-only connection for 
production setups.
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Note on Xsan support

 ρ Version 1.7 of just:in multi highly improves the writing frequency/load behavior on 
Xsan and other similar storage systems. This is done by the possibility to specify the 
frames per flush and storage buffer size. The frames per flush value defines after how 
many frames the chunk will be written to disk, the storage buffer size defines how 
many chunks are possible. The total size of the buffer is calculated by multiplying 
these two values (see Video Output Buffer and Output Buffer Segments settings on 
this page).

Important note on codecs availability and deployment on Mac OS X

 ρ Due to licensing restrictions, we’re not allowed to ship any Apple codecs along with 
our products. In order to obtain the appropriate professional Apple codecs (ProRes, 
IMX etc.) you need to have an already installed version of either Final Cut Studio 3 or 
Final Cut Pro X on the machine used for either ingest or playout.

 ρ The professional codecs are also available via a Software Update upon a new 
installation of Final Cut Pro X or as an update installer under the following URL: 
http://support.apple.com/kb/DL1396. Please check regularly for new updates on 
Apple’s support site or via the Software Update mechanism built into Mac OS X. 
Please note that this update installer will check for an already installed version of 
Final Cut Pro (7 or X)!

 ρ The same applies to other codec or MXF player vendors: if you plan to either 
record or play MXF files, please contact MXF4mac for licensing information under 
http://www.mxf4mac.com. This is particularly the case when you intend to record 
into the AVC-Intra 50/100 format.

 ρ If you plan to either record or playout DNxHD encoded files you need to install the Avid for 
QuickTime codecs. As of this writing actual Avid QuickTIme codecs can be downloaded 
under the following URL: http://avid.force.com/pkb/articles/en_US/download/
Avid-Codecs-LE-2-3-9?popup=true&NewLang=en&DocType=1450&q=Avid%20
QuickTime%20codec&site=kbase&filter=0&subfilters=&ProductCategory=
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CONFIGURATION

PRESETS: DEFINE CAPTURE PRESETS3.3 

A capture preset in consists of the following options: TV Norm, Container, Aspect Ratio, Codec and 
Audio Channels. Before using just:in multi for the first time you will need to create a capture preset. 
To do this press the Preset pull-down menu and select New…. When you’re done definining the 
options, click on the save button and you will be prompted to enter a preset name. Click Save and 
enter a descriptive name for it. Make sure that you save this preset into /Library/Application Support/ 
ToolsOnAir/Just In. Do not use one or more of the following characters: / @ : | \ < >. To speed up the 
process you can also duplicate an existing preset and change it to your needs accordingly.

Preset
The name of the defined capture preset.

TV Norm
Set a TV norm here as required (PAL, NTSC, HD or 
Custom for H.264 settings).

Container
Choose between MXF OP1a, AVFoundation QuickTime, 
QuickTime, Avid OP-Atom MXF or AVFoundation MP4. 
For MXF ingest other than Avid OP-Atom MXF please 
see the note in Chapter 3.7 with regard to the MXF 
activation steps.

Aspect Ratio
Configures the aspect ratio (4:3 or 16:9).

Codec
Choose from a list of available codecs for the selected 
container (QuickTime, AVFoundation QuickTime, MXF, 
Avid OP-Atom MXF or AVFoundation MP4).

Audio Channels
Select the number of audio channels and the audio 
track alignment (Mono or Stereo) you would like 
to capture. If you’re using MXF as a container you 
will not be able to choose between Mono or Stereo 
alignment. They will all default to Mono.

You will find some demo capture presets to get you started in the Additional Content folder of the 
Just In Installer for your convenience.

Just copy them to /Library/Application Support/ToolsOnAir/Just In/ and you’re ready to go. You 
can use them as a reference for new presets.
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CONFIGURATION

PRESETS: DEFINE MULTIPLE DESTINATIONS PRESETS3.4 

One of the new features of version 1.7 is the ability to define multiple destination settings. To do so, 
please select the appropriate paths for each destination you want to save and hit Save. You will then 
be prompted to enter a preset name. A destination preset consists of the following options:

Preset
The name of the defined destination preset.

Container Types
First select “New...” from the Preset pull-down 
menu, then click on the “+” button to create a new 
entry. Choose between Main Container (where the 
media will be written to), Reference Movie (where 
the Ref. movies will be written to) or XML (where 
the sidecar XML files will be written to). You can 
choose multiple destinations for every preset.
Once you have defined your destination preset, 
click Save and enter a descriptive name for it. Make 
sure that you save any preset(s) into /Library/
Application Support/ToolsOnAir/JustIn.

Reference Movie Path
Enter the path where you want to store the reference 
movies (QuickTime and Final Cut Pro X).

XML Path
Enter the path where you want to store the XML 
sidecar files with descriptive metadata in it. If you 
want to import them alongside your media, it might 
be useful to write them to the same path. The XML 
sidecar file gets written automatically once the 
recording has ended provided that the sidecar XML 
input/output files have been previously defined (see 
the XML documentation available separately).

Fallback Path
Define one or more fallback paths where you want 
to store your media in case something happens with 
the primary storage. Once a fallback occurs just:in 
multi will continue writing on the fallback path and 
try to keep its frame accuracy while switching to 
another volume defined as the fallback destination.

About Multiple and Fallback Destinations: just:in multi features a sophisticated fallback mechanism 
(for Hi-Res) for out-of-storage, network connection loss or even power outage scenarios on the 
storage side. just:in multi ensures that you will still have your recordings available for later use, as 
long as a power outage didn’t affect any hardware components or any serious file system corruptions 
happened. The Fallback Destination mechanism will only work when a Fallback Destination Path has 
been defined within the given destination preset.
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CONFIGURATION

PRESETS: APPLE PRORES, AVID DNxHD AND H.2643.5 

Apple ProRes (all flavors)
When using any of the Apple ProRes codecs you will 
be prompted to select a framerate and resolution.

Avid DNxHD (8-bit only)
When using the Avid DNxHD codec, you will be 
prompted to select a resolution and the appropriate 
Color Level (RGB or 709). Please make sure that you’re  
using a recommended machine and a storage system 
with enough capacity and bandwidth!

H.264 codec
When using the H.264 codec in either AVFoundation  
MP4 or AVFoundation QuickTime container  you will be 
prompted to define several settings such as:
Resolution, Framerate, Profile, Bitrate, Allow 
B-Frames, GOP-Size and Entropy Mode.
Again make sure to use a recommended machine to 
encode H.264 material.

CONFIGURATION

NAMING CONVENTION PRESETS3.6 

Naming Conventions Presets
Under Names you can define the desired naming 
con ventions for your clips. You can add your own 
variables by entering the “%” prefix followed by 
the wanted naming expression as well as static 
text expressions (without the “%” prefix). The 
clips will be named accordingly. The customized 
“%” variables will be displayed as additional 
fields in the Just In Multi GUI in the Clip section.

Attention

 ρ Naming presets are only visible on the machine on which they were created!
 ρ The naming convention preset database is stored locally in the file:  

/Library/Application Support/ToolsOnAir/Just In/nameconventions.db
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CONFIGURATION

ACTIVATION3.7 

To activate just:in multi click on the Activation tab and enter an activation key either for demo (without 
watermarks) or permanent use (licensed) in the Activation Code field.

Note

 ρ just:in multi works in full-featured mode without an activation key! In Trial Mode you 
will see a logo watermark every four seconds. Please contact ToolsOnAir to get a 
temporary activation code that removes the watermark.

just:in multi Activation panel
just:in multi can be activated by clicking on the 
Activation tab of the Just In QT Preference Pane 
(System Preferences).

Machine ID
The machine ID will be automatically generated 
by just:in multi and is needed to activate any 
number of ingest channels in either demo or 
permanent activation mode (intentionally left 
blank on screenshot).

License Code
After receiving the license activation code from 
ToolsOnAir insert it into the Activation Code 
field and hit the Enter key to activate the Demo 
or Permanent license. Please make sure that 
you have write permissions to the /Library/
Application Support/ToolsOnAir/ folder!

Note

 ρ just:in multi has the ability to ingest into a MXF OP1a container already built-in. There 
is a license fee though to activate it. Due to license agreement contracts you will have 
to contact Hamburg Pro Media/MXF4mac to receive your license to use their MXF 
writing technology in combination with just:in multi! Just take a screenshot of the 
Activation tab and send it to MXF4mac (licensing@mxf4mac.com). They will be more 
than happy to issue you the license file promptly.

 ρ Should you want to use the AVC-Intra codec for your recordings then please contact  
your preferred MXF4mac reseller to purchase their AVC-Intra Codec for use with 
just:in multi.

 ρ just:in multi can ingest into an Avid OP-Atom MXF container right away without a 
dedicated license!
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4 USING THE APPLICATION

Once you are done with the configuration of the presets, close the Just In QT preference pane, 
navigate to /Applications/Just In and double-click on Just In Engine QuickTime. The engine 
application will start up and display information about each channel that has been selected in the 
Just In QT preference pane. Congratulations! You are only a few steps away from your first recording!

If there is no active channel this message will show 
up after launching Just In Engine QuickTime.

After pressing Activate the application will quit 
and the Just In QT preference pane appears. 

Please refer to chapter 3 on how to properly setup 
just:in multi. 

If everything has been configured properly, the Just In Engine QuickTime diagnostics window 
displays the number of available channels, as well as the owner of the channel and information about 
the activation status (activated vs. trial mode). By clicking on the Show channel log button you will 
be automatically directed to the log information for the given channel.

Arranging the Just In Engine QuickTime window to be in front of others

If you want to arrange the Just In Engine QuickTime diagnostics window in front of others, then 
select the option  “Always on top” from the Window Menu of Just In Engine QuickTime.

Connecting to channels via Bonjour or over IP with the Just In Multi user interface
Start Just In Multi and select the channel(s) 
(Shift-Click a checkbox to select all available 
channels) you wish to control and record on. 

Check “Release channels on quitting”, if you 
want Just In Multi to release the selected channels 
upon quitting. Press “Connect” to open the user 
interface.
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Connecting to the engine using dedicated IP addresses

You can connect to your channel(s) either via Bonjour (automatic discovery) or IP address (manual 
entry). The port number must match the one entered for each channel in the Just In QT preference 
pane (see Page 9). In order to connect to a channel over IP double-click on the text “Double click 
to add a channel” and enter your preferred Channel name, Host IP address and Port number. 

Don’t forget to click on the checkbox Use to connect to the appropriate channel or Shift-Click to 
connect to all channels. You can sort by channel name(s) by clicking on the column header “Channel 
Name”.

You are now ready to proceed with your first recording. Select the appropriate capture and destination 
presets, then press the Record button. You will be recording in Crash mode.

Please read on to the next chapter explaining the detailed usage of the Just In Multi user interface.
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5 INTERFACE

1

2

6

7

8

9

10

11

12

3 4 5

1 Preview
Shows the preview of the video input.

2
Audio Preview & Reference
Shows the audio preview levels and displays 
the presence of a VTR and LTC signals. Click 
on the audio levels to preview the audio signal. 

3 Batch Digitize
Press this button to enter Batch mode.

4 Crash Recording
Press this button to enter Crash mode.

5
Schedule Recording
Press this button to enter Schedule mode 
(Calendar events, see also chapter 6.4).

6
Record Button & VTR Control
Start recording or control a VTR deck. Click on 
the timecode display to switch from timecode 
information to recording length.

7
Clip Properties
Used to define the naming conventions and the 
resulting clip name.

8
Timecode Properties
Select the timecode source and define a time-
code offset here.

9
Metadata Properties
Select a previously defined metadata set from the 
drop-down list and enter data in the appropriate 
fields.

10

Capture + Destination Settings
Select previously defined capture and 
destination presets for capture instance 1 and 2 
from the dropdown-list before recording as well 
as the reference movie format if needed.

11

Batch Recording
Shows batch settings and a list of queued batch 
jobs. Import CSV batch lists directly into the list. 
Only active and visible in batch mode.

12

Scheduled Recording
Shows a list of the upcoming 10 events in the next 
24 hours. Only visible in Schedule mode. Works 
in combination with Apple Calendar.
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INTERFACE

PREVIEW5.1 

When the mouse pointer resides in the preview 
area there is a small «i» sign in the upper right 
corner. Press it to switch to the info view.

The info view can be closed in the same way  
(by clicking the «x» in the upper right corner).

The information in the overlay displays the 
Channel Name as well as the Buffer and Memory 
status.

The memory bar show the remaining free space 
in MBytes. The percentage represents the free 
memory space.

In this example 210.74 MB of memory is used.

In the event of a connectivity problem a large 
attention sign shows up in the preview area. 
Please contact your administrator to have him 
check the connection to the engine.

In the event of a signal loss or inconsistency,  
Just In Multi will display a “No Signal” alert to 
the user and stop the current recording in order 
to safeguard the recorded clip. Once the signal is 
back the user can restart the recording.
You can choose though to continue writing into 
the same container by checking this option in the 
Just In QT preference panel (see info on Page 6).    
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INTERFACE

RECORD BUTTON & TIMECODE DISPLAY5.2  

41
2

1

Record
Use the Record button to start 
or stop capturing in both Crash 
and Batch modes.

2
SMPTE Timecode
The timecode display has several 
states which are explained in the 
chapter “Record Button States”.

INTERFACE

CAPTURE INSTANCES SETTINGS5.3 

42

1

1

Capture-1 Instance
Select the appropriate settings 
for the Capture-1 instance. 
If needed choose your favorite 
Reference movie (QuickTime 
7 or Final Cut Pro X) format 
from the pull-down menu.

2

Capture-2 Instance
Select the appropriate settings 
for the Capture-1 instance. 
If needed choose your favorite 
Reference movie (QuickTime 
7 or Final Cut Pro X) format 
from the pull-down menu.

Note

 ρ New in version 1.7 are two capture instances per channel. This allows to capture 
any combination of presets within on single channel and is ideal for high-res / proxy 
recording scenarios.

 ρ The last selected setting will be loaded automatically after the Just In Multi GUI has 
been launched.
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INTERFACE

VTR CONTROL5.4 

4 4 4

4 4 4 4

42 4 6 8

1 3 5 7 49

1
Set In Point
Defines the in-point, used in 
batch recording.

2 Goto In
Cues the tape to the in-point.

3

Rewind
Tape stopped: Press once to 
rewind the tape. Press it again 
or press stop to stop rewinding.
Tape running: Tape rewinds 
while pressed.

4
Previous Frame
Steps one frame towards the 
beginning of the tape.

5 Play/Stop
Play or stop the tape.

6
Next Frame
Steps one frame towards the 
end of the tape.

7

Fast Forward
Tape stopped: Press once to 
fast forward the tape. Press it 
again or press stop to end fast 
forwarding.
Tape running: Tape fast for-
wards while pressed.

8 Goto Out
Cues the tape to the out-point.

9
Set Out Point
Defines the out-point, used in 
batch recording.
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INTERFACE

BATCH RECORDING5.5 

41 42 4 43 4

5 67

1
Cue to …
Cues to the selected in- or out-
point. Only visible when the 
mouse is above the field.

2
In-Point
Defines the in-point of a batch 
item.

3
Out-Point
Defines the out-point of a batch 
item.

4

Duration
Defines the duration of a batch 
item. If the in- and out-point are 
set, the duration is calculated 
automatically.

5
Log
Adds a new batch item to the 
batch list.

6
Reset
Resets all three timecode fields 
to 00:00:00:00.

7
Load
Starts the Batch Import 
process of a text file.

8
Save
Saves the content of the Batch  
list into an editable/archivable 
text file for later use.

9
Clear table
Clears the entries of the Batch 
list table.

10

Batch List Header
Clicking this element of the 
batch list header switches 
through the following modes: 
Inpoint, Outpoint and Duration.

9 8

10
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6 RECORDING
just:in multi offers three different recording/ingest modes:

 ρ Crash Mode: record video signals on the fly.
 ρ Batch Mode: record a predefined batch list of clips from a connected VTR deck over RS-422.
 ρ Schedule Mode: record clips based on events in the local Apple Calendar calendar of the engine 

machine.

just:in provides integrated machine control over RS-422. Note that the maximum recording length 
is 12 hours per clip in any case.

Sources: SDI signal from VTR, 
Camera, Live or Satellite feed

Just In Engine QuickTime
Just In Multi GUI

Video stream

Timecode

Control signals

RECORDING

RECORD BUTTON STATES6.1 

The record button and timecode have different states. Each state is listed in the following.

Connected (with no preset selected)
Indicates that there is a connection to a capture device but 
no recording is in progress. The record button is not active 
until all settings are valid.

Recording + Writing
Indicates that a record is in progress and files are being 
written to disk.
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RECORDING
CRASH RECORDING6.2 

Select Preset
Select the preferred preset from the Setting pop-up 
menu in the Capture section.

Specify Clip Name
Specify a clip name or select a name convention from 
the Name convention pop-up menu.

Clip Name Already Exists
If you use the same clip name twice or the file name 
already exists in the capture folder a number will be 
appended to the file name and the resulting clip name 
will be displayed in yellow.

Capture
Press the record button to start or stop recording. 
While recording the preview is bordered with a red 
frame.

Keyboard Shortcuts for recording and 
channel selection
Select/Deselect channels by pressing 
“Alt-<ChannelNumber>” and 
Start/Stop recording by pressing “Command-R”. 

LTC over Audio Info
If a LTC over audio signal is fed into the video card or 
the sound input of the computer, a LED will show the 
status accordingly.

Split Clip Function
While recording you can hold down the Option (Alt) 
key and the record button will turn into Split Mode 
(noticeable by a vertical line that crosses the record 
icon). Clicking on it or pressing the F3 key will generate 
a new file along with its companion sidecar XML.
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RECORDING

BATCH RECORDING6.3 

Select Preset
Select the preferred preset from the Setting pop-up 
menu in the Capture section. Remember to select a 
VTR option (e.g. RS-422) in the Timecode section, in 
order to activate machine control.

Specify Clip Name
Specify a clip name. After editing the name press 
return. If desired fill out the other fields.

Note

 ρ The batch table is not directly modifiable. If you want to edit a batch job, click on it 
and edit its parameters as explained above and hit the enter key to confirm.

 ρ You can jump to the in- or out point by pressing the symbol in the Inpoint field. Note 
that the symbol only shows up when the mouse pointer is above the Inpoint field.

 ρ In order to allow for metadata flexibility, you can apply a metadata set for each clip 
logged by selecting the clip and choosing the appropriate metadata set in the clip 
section.

Define Batch List
Enter an in-point and an out-point in the appropriate fields and press Log to create a new entry 
in the batch table. Repeat this step until your batch list is complete. You may also use the In and 
Out buttons to set the current timecode as your in- or out-points. Alternatively you can import a 
predefined text (.csv) file by pressing the Load button and adjust the import parameters (separate 
window) as needed. If you want to export your batch list for archiving purposes, then click the Save 
button. Click Clear table, if you want to reset the entries in the batch table. 
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Capture
Press the record button to start or stop recording. While 
recording the record button glows and the preview is 
bordered with a red frame.

VTR Detection Info
If a VTR is detected a green LED will be shown in the 
Just In Multi GUI accordingly. Remember to select 
the VTR - RS-422 option in the Timecode section, in 
order to activate machine control.

VTR Preroll settings
You can set the VTR preroll settings in the Just In QT  
preference pane. Values range from 1-10 seconds.

RECORDING

SCHEDULED RECORDING6.4 

One of the great features of just:in multi is that it uses out-of-the-box features that Mac OS X provides 
and the Apple Calendar application is used for scheduling because of that. The integration between 
just:in and Apple Calendar is very straightforward and easy to use. Once you select a channel in the 
Just in QT preference pane and name it according to your needs, a calendar with that same name will 
be automatically created for that/every channel. So, all you need to do is to set your calendar events 
in Apple Calendar and they will be instantly visible in the Schedule section of Just In Multi. Please 
remember that all events have to be created on the machine holding the Just In Engine QuickTime 
engine and these events are automatically displayed in the Just In Multi GUI. 
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Select Preset
In the capture settings area select your preset from the 
“Setting” pull-down menu.

Clip Naming in Apple Calendar
The clip length will be based on the event‘s duration, 
the clip name will be the event‘s name. One can add 
<Channel>, <Date> and <Time> variables.

Note

 ρ Repeating an Apple Calendar event would result in a file which gets overwritten every 
time the same event is executed. To avoid this you can add the variables <Date> and 
<Time> to the clip name of the event. This automatically appends the date and time  
(= beginning of the corresponding Apple Calendar event) to the clip name.

Event List in Just In Multi
The scheduled events show up immediately after 
creating them in Apple Calendar.

Maximum Record Length
Due to the maximum record length, the Just In Multi 
user interface will display a warning when a scheduled 
Apple Calendar event exceeds the maximum length of 
12 hours even when using MXF.

Schedule Warnings Panel
A handy new feature to the schedule mode is the ability 
to set specific reminders in the event of a mixed ingest 
operation. Let’s say that you have scheduled one or 
more recordings in the future, but would like to do 
some crash recordings in between. Just In Multi will 
ask, if you want to leave schedule mode and set the 
logged Apple Calendar events on temporary hold.
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Once you’re done with your crash recording you would 
then switch back again to schedule mode, but in case 
you forget to do so, you can use the schedule reminder 
settings under the menu “Just In Multi -> Preferences”.

First check Schedule warnings then enter the intervals 
that you want these warnings to show up ahead in 
time (in seconds and values > 60) and choose one of 
the following wanted operations: Force Scheduling or 
Continue Recording.

Continue Recording
Select this option, if you want to continue recording, 
even when a scheduled event has been set. That 
schedule will then be disregarded.

Force Scheduling
Select this option, if you want to abort an ongoing 
crash recording and revert to the scheduled recording.

The first picture above shows the warning that will pop up as a visual support to the operator whilst 
in crash recording mode. There you can decide whether to directly switch into schedule mode or 
continue recording. If you press Switch to schedule, then Just In Multi will stop recording and 
automatically switch to Schedule mode.

Gapless Scheduled Recording
In versions of just:in multi (pre-1.5) it was not possible to record two subsequent events where the end of 
the first clip was the start time of the second clip. Starting with version 1.5 of just:in multi, Apple Calendar 
events can be used to perform gapless schedule recordings on a frame accurate level.

RECORDING

VIDEO PREVIEW QUALITY AND SPEED SETTINGS6.5 

New in version 1.7 is the ability to set the both the Video Preview Quality and the Video Preview 
Speed to optimize the network and encoding bandwidth. By reducing both parameters to lower values, 
you can ideally relieve the pressure on the CPU and therefore increase stability and, depending on the 
codec used, the amount of recording channels.
You can set these values in the menu “Just In Multi -> Preferences”.

Video Preview Quality and Speed settings
Adjust the desired values for Video Preview Quality 
(Low -> High) and Video Preview Speed (Low -> Fast).
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RECORDING

JUST IN ADOBE PANEL FOR ADOBE PREMIERE PRO CS6/CC6.6 

In addition to the Just In Multi user interface, there’s the option to use our Just In Adobe Panel for 
Adobe Premiere Pro (Mac) to directly record and import files into Adobe Premiere Pro CS6 (6.0.5) and 
CC (7.2.x and higher). It currently provides the following features:

• single / multi-channel ingest (MOV and MXF containers) over SDI or HDMI (depending on the PCI 
video card or Thunderbolt device used) in combination with our Just In QuickTime Engine v1.7.

• automatic import into an Adobe Premiere Pro CS6/CC project panel with growing file support for 
MOV and MXF containers.

• Crash and Gang recording modes.

Please follow these steps to use it:

1. Define a port for every channel you would like to connect to from the Just In Adobe Panel in the 
Just In QT preference pane (see page 8). Connection from the Just In Adobe Panel can only be 
done via a direct IP setup.

2. Open the Additional Content folder in the Just In installer window. Double-click the Justin Adobe 
Panel.zxp package to install the Just In Adobe Panel via the Adobe Extension Manager CS6 or CC 
(separate Adobe install routine).

3. Launch Adobe Premiere Pro CS6/CC, choose your preferred project or create a new one and navigate 
to Preferences -> Media. Uncheck Write XMP ID to Files on Import and verify that Automatically 
Refresh Growing Files is checked. Enter a lower value for the refesh rate if needed (min. 10s).

4. Make sure that the Just In Engine QuickTime engine is running. Navigate to the Window menu and 
select Extensions -> Just In Adobe Panel. The Just In Adobe Panel gets initialized and started. 
Click on the Settings tab, add a channel entry by clicking on Add Channel and enter the desired 
channel name, IP Address and Port number. Once done, click on either Connect or Connect All to 
connect to the given channel(s). Windows: enter the Mapped Network drive to access the files.

5. Switch to the Capture tab, enter the desired clip name and select the appropriate capture and 
destination presets already defined in the original setup (see pages 11-12). Click on the Record 
button to initiate the recording. Premiere Pro will import the recording after a short while. You 
can then start editing your clips in the timeline while the file is growing (trim out to extend the 
growing file). After the recording has been stopped one last update of the duration will be executed.  

 
Just In Adobe Panel Settings (Mac / WIN) Just In Adobe Panel Capture
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7 CREATING CUSTOMIZED XML
This section describes how to adapt the standard XML schema of just:in multi to create customized 
sidecar XML files for further workflow processing once a recording is terminated.

i CREATING CUSTOMIZED XML

SETTING UP THE XML EXPORT REQUIREMENTS7.1

Setting up the XML export within just:in multi is very straightforward. The Just In installer automatically 
creates two new separate folders named StartupXML and ExportXML within the following directory:
<yourharddisk>/Library/Application Support/ToolsOnAir/Just In

Inside these folders you’ll find some sample files to get you started. Please note that the XML files 
MUST always carry the same name in both folders, so that the Just In Multi XML writer can access 
them correctly. A well formed folder structure will look like this:

StartupXML folder ExportXML folder

CREATING CUSTOMIZED XML

SETTING UP THE XML DESTINATION IN THE PREFERENCE PANEL7.2

In order to write a sidecar XML file upon completion of a recording, you have to define an appropriate 
destination path first. Run the Just In QT preference pane switch to the Presets tab and define the 
XML path of choice by clicking on the “+” sign. Select XML from the Container pull-down list and 
choose the desired path.

Destination Presets configuration in Just In QT Preference pane
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CREATING CUSTOMIZED XML

ABOUT THE LOGIC BEHIND THE XML EXPORT7.3

The just:in multi XML Export is based on dedicated XML files found in the folders StartupXML 
and ExportXML. The example.xml file residing in the StartupXML folder holds the customizable 
information that you would like displayed or made accessible for data entry in the Just In Multi GUI. 

The sample.xml file residing in the ExportXML folder is the output template, where you define the 
variables that will be exported at the end of a recording. The final result will be an XML file named 
after the defined clip name and holding all information that you entered in the GUI and/or set as 
just:in multi system variables in the output template.

CREATING CUSTOMIZED XML

EXPLORING THE EXAMPLE FILE IN THE STARTUPXML FOLDER7.4

Let’s have a look at the XML structure of the example.xml document below.

<?xml version=”1.0” encoding=”UTF-8” ?>

<metadataset>

	 <!--	first	class-type	=	Selection	-->
 
 <control>
 
	 <!--	this	definition	will	be	used	as	variable	(%quality)	in	the	export	xml	-->
	 	 <name>quality</name>
  
	 <!--	this	label	is	displayed	in	the	Just	In	Multi	GUI	-->
	 	 <label>Quality</label>
  
	 <!--	this	pull-down	menu	will	be	shown	in	the	Just	In	Multi	GUI	-->
	 	 <type	class=”Selection”	default=”2”>
	 	 	 <item>Low</item>
	 	 	 <item>Medium</item>
	 	 	 <item>High</item>
	 	 </type>
	 </control>

 
	 <!--	second	class-type	=	Text	-->
 
 <control>
	 	 <name>customText</name>
	 	 <label>Custom	Text</label>
	 	 <type	class=”Text”	default=”Insert	your	text	here”></type>
	 </control>

 
 <!--	third	class-type	=	Checkbox	-->
 
 <control>
	 	 <name>special</name>
	 	 <label>Special</label>
	 	 <type	class=”Checkbox”	default=”0”></type>
	 </control>

</metadataset>
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The <metadataset> tag is the root tag of the set of definable data. Every information element that 
can be displayed in the GUI is found within a <control> tag, where one can define the values within 
the  <name>, <label>, <type> and the respective <item> tags.

There are three <class> attributes available: “Selection“, “Text” and “Checkbox”.

In this example we added a new <control> tag (blue text) to the example.xml, where we defined a 
new section of <name>, <label> and <type> tags. We chose to add a Checkbox type to the code. 
Every similar addition to this example.xml file will be reflected in the Just In Multi GUI upon reload 
of the file via the Metadata Set pull-down menu. 

Metadata Set without Checkbox element Metadata Set with Checkbox element

CREATING CUSTOMIZED XML

EXPLORING THE EXAMPLE FILE IN THE EXPORTXML FOLDER7.5

The example.xml file within the ExportXML folder contains the definition of the output template. 
Keep in mind that you can apply you own XML schema to the output template which is the biggest 
advantage of the just:in multi XML implementation.

Again, let‘s have a look at the structure. In this example we want to output the tags previously defined 
in the example.xml within the StartupXML folder as well as some internal system variables exposed 
by just:in multi (see pages 31-32). The <name> tags previously defined (quality, customText and 
special) are now used as variables in the output template, so that any entry made in the Just In Multi 
GUI will be reflected in the final output. The system variables %Just_In_Clipname and  %Just_In_
Capture_Duration used in this example will output the final file name (incl. naming conventions) and 
the duration of the clip accordingly.

The structure of the example.xml file within the ExportXML folder looks like this:

<?xml version=”1.0” encoding=”UTF-8” ?>

<file	name=”%Just _ In _ Clipname”	duration=”%Just _ In _ Capture _ Duration”>
  
	 <quality>%quality</quality>
 
	 <text>%customText</text>
 
	 <special>%special</special>
 

</file>
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The final sidecar XML output will therefore look like this:

<?xml version=”1.0” encoding=”UTF-8” ?>

<file	name=”MyFirstClip”	duration=”00:00:15”>
  
	 <quality>Medium</quality>
 
	 <text>This	is	where	I	entered	my	text</text>
 
	 <special>1</special>
 

</file>

This sidecar XML file will be generated once the recording has finished and moved to the defined 
path.

CREATING CUSTOMIZED XML

INTERNAL SYSTEM VARIABLES (CAPTURE AND GENERAL)7.6

just:in multi exposes a variety of internal system variable keys to ease up metadata processing. 
These are divided into capture related and general keys. The following table lists them accordingly.

SYSTEM VARIABLE KEYS 
(CAPTURE SECTION) DESCRIPTION

%Just_In_Container

Will be replaced by one of the following values:
“QuickTime”,”MXF GC”, ”MXF D-10”, ”MXF XDCAM”, 
”Avid OP-Atom”, “AVFoundation QuickTime”, 
“AVFoundation MP4”.

%Just_In_Timecode_Source

Will be replaced by one of the following values:
“Computer Time”, ”VTR - RS-422”, ”VTR FireWire”, 
”LTC over Audio”,”Miranda Little Red”,”Capture card 
LTC”,”SDI Embedded”.

%Just_In_Framerate
Will be replaced by one of the following values: 
“23.976”, “24”, “25”, “29.97”, “30”, “50”, “59.94”, 
“60”.

%Just_In_Aspect_Ratio Will be replaced by one of the following values: 
“4:3”, “16:9”.

%Just_In_Capture_Codec Will be replaced by the codecs full name.

%Just_In_Audio_Channels
Will be replaced with the actual number of audio 
channels writing into the container: 
“2”, “4”, “8” or “16”.

%Just_In_Capture_Resolution Will be replaced by the resolution of the target 
format. E.g. “1920x1080”, “720x486”.

%Just_In_Capture_Width Will be replaced by the capture width. E.g. “1920”.

%Just_In_Capture_Height Will be replaced by the capture height. E.g. “486”.
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The general keys exposed by just:in multi are listed in the following:

SYSTEM VARIABLE KEYS 
(GENERAL) DESCRIPTION

%Just_In_Capture_Split
Will be replaced by one of the following values: “0” - 
no split occurred, “1” - a split occurred, “2” - last clip 
of the split sequence.

%Just_In_Previous_Split_Reference_Clip
Will be replaced by the filename of the clip before 
the current recording one. Empty string if no split 
occurred.

%Just_In_Capture_Duration Will be replaced by the length of the recording in 
“standard time”. E.g. “00:30:00” - 30 minutes.

%Just_In_Capture_Inpoint Will be replaced by the Inpoint timecode. This is the 
timecode of the first frame. E.g. "10:00:00:00’.

%Just_In_Capture_Outpoint Will be replaced by the Outpoint timecode. This is 
the timecode of the last frame. E.g. "11:00:00:00".

%Just_In_Clipname Will be replaced by the Clipname with extension. 
E.g. "sample.mov".

%Just_In_Full_Clipname Will be replaced by the full clipname. E.g. “/path/to/
the/movie.mov”.

%Just_In_Custom_Date
Will be replaced by a representation of the keys’ 
value. E.g “%d/%m/%Y %H:%M:%S” will be 
replaced by 01/01/2011 15:32:53.

Every field of the naming convention is available for metadata processing - so just use the same key 
as in the naming convention. There’s one special case though:

NAMING CONVENTION DESCRIPTION

%Name (or any custom variable)

Will be replaced by the contents of the “Name” 
field (or any custom fields) of the “Clip” section, 
in schedule mode this field will be the name of the 
Apple Calendar event.
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CREATING CUSTOMIZED XML

WRITING METADATA IN A QUICKTIME FILE7.7

just:in multi provides full support for both standard and custom QuickTime metadata. All QuickTime 
standard fields use plain text. Note that the string length is limited to 255 characters! 

The Just In installer will copy an example XML template named QuickTime.xml to the StartupXML 
folder during the installation process. Let’s create an entry based on this example file. 

<control>
								<name>com.apple.quicktime.album</name>
								<label>Album</label>
								<type	class=”Text”	default=”The	Album”></type>
</control>

This entry would expose the “Album” field of the QuickTime movie. The Label in the Just In Multi GUI 
is “Album” - the corresponding key is “com.apple.quicktime.album”.

QUICKTIME METADATA LABELS QUICKTIME METADATA KEYS

Album com.apple.quicktime.album

Artist com.apple.quicktime.artist

Author com.apple.quicktime.author

Comment com.apple.quicktime.comment

Copyright com.apple.quicktime.copyright

Description com.apple.quicktime.description

Director com.apple.quicktime.director

Title com.apple.quicktime.displayname

Information com.apple.quicktime.information

Keywords com.apple.quicktime.keywords

Producer com.apple.quicktime.producer

Software com.apple.quicktime.software

Year com.apple.quicktime.year
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8 USING MOXA NPORT 5650
This section describes how to set up the parameters for use with the Moxa NPort 5650 serial device 
server in combination with just:in multi and a Blackmagic DeckLink Quad video card in order to control 
tape decks over dedicated RS-422 connections. Please follow these steps:

1. Install just:in multi 1.7, if you haven’t done so already and check that the Moxa components 
(moxattyd and moxattyd.cf) are installed into /Applications/Just In/moxadeamon/.

2. Launch Apple Terminal.app, type: defaults	write	com.toolsonair.justin.moxa	1	and 
confirm with the Enter key.

3. Open the moxattyd.cf configuration file and add all needed ports by following this logic (we will 
define 4 channels and serial ports in this example): 

ttyp1	<ip _ address _ moxa _ device>	950
ttyp2	<ip _ address _ moxa _ device>	951
ttyp3	<ip _ address _ moxa _ device>	952
ttyp4	<ip _ address _ moxa _ device>	953

4. Configure the serial port on the Moxa NPort 5650 device by opening a browser connection 
and entering the IP Address of the Moxa NPort 5650 device. Once the device’s homepage has 
been loaded, click on Serial Settings and the desired port to configure it by using the following 
parameters. Once done, click Submit to confirm your settings:

5. Launch the moxattyd daemon by entering the following commands in Terminal.app:

cd	/Applications/Just\	In/moxadaemon/
./moxattyd

6. Open the Just In QT preference pane and allocate the selected channels to the configured serial 
ports. The ports numbering is always of a one-to-one type. You are now ready to use the serial 
connections.
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w 9 KNOWN ISSUES

(1) Problems resulting from not running just:in with an administrator account

To avoid authentication problems always run just:in with an administrator account.

(2) FireWire support End-of-Life

FireWire support will remain basic and won’t be developed any further due to the technology 
change to Thunderbolt.

(3) Recording Limitation

The QuickTime and MXF container formats are still imited to 12 hours.

(4) AJA NDD 10.5.2 drivers compatibilities
Version 1.7 will only support AJA drivers 10.5.2 and higher.

(5) AJA Multichannel audio issue in HD NTSC
When using an AJA Io 4K Thunderbolt device with HD NTSC 29.97 formats the audio may be corrupted. 
AJA has been notified and working on a fix.

(6) Mixing AJA and BMD cards may cause TC to TC asynchronicity

When using any combination of AJA and BMD cards with the latest drivers, an asynchronicity 
between TC information displayed on the relevant channels may occur. This issue has been reported 
to both card vendors.

(7) Mac OS X 10.9 issues with ATTO FC-8xEN FiberChannel cards

We’ve seen major driver instability with the ATTO Celerity 8 Gbit Fiber Channel cards. We strongly 
discourage the use of these cards in combination with Thunderbolt based expansion chassis. 
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